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PREFACE

“Loyola Computer Applications “ is in your hands.
Students with average 1Q always struggle to cope up studies. They
always seek for the best, sources to learn and score high marks.

The pattern of the question being asked in the exams has changed
dramatically and the difficulty level has also increased considerably. To
succeed in board exams and to actualize your dream, you are required
to prepare strategically and study in a focused manner.

This book gives important tips which covers the entire chapter.
Loyola serves the above cited purpose in perfect manner.

» Specially designed for coaching students of different levels.
(Slow learners, average and Topper students)

» Lot of additional questions are given for-toppers

» The “EC Computer Applications™ is prepared with due care on the
lines of the Govt. ExaminationValuation, the easy method of studying,
the lesson and the perfectway of answering the questions.

» The answers are well prepared, briefly and easily for the students to
study without any difficulty and stress.

Simplified text matter
Focused on coverage of textbook.
MCQ'’s are framed based on new pattern.

Included Govt. question papers with their key.

v Vv Vv V V

Comprehensive questions are designed for average and above
average students based on key points.

Wish you 2l the Pest

Loyola Publication
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Multimedia

Multimedia - An Overview

Multimedia and their features:
Multimedia is an integration of many types of media like text, graphics, images, audio,
animation, Video on a single medium in the same information unit.

Features:

» Multimedia allows the users to combine and change data from various sources like image,
text, graphics, video, audio and video to a single platform.
» Multimedia has become the latest enriching experience in the field of information sector.
» Multimedia application plays vital role in terms of presenting information.to the users.
Multimedia Components:
Multimedia has five major components namely text, images, sound, video and animation.
Text:
Text is the basic components of multimedia and most common ways of communicating
information to other person.
Text is of two types namely
v Static Text
v Hypertext
Animation:
Animation is the process displaying still images so.quickly so that they give the impression
of continuous movement.
Features:
» Inanimation the screen object is a vector image in animation.
» Using numerical transformations'the movement of that image along its paths is calculated
for their defining coordinates:
> The least frame rate of at least 16 frames per second gives the impression of smoothness and
for natural looking it should be at least 25 frames per second.
» Animations may be in two or three dimensional.
» Animation tools are very powerful and effective.
» The two basic types of animations are Path animation and Frame animation.
Image file formats:
» TIFF (Tagqged Image File Format)
» BMP (Bitmap)
» DIB (Device Independent Bitmap)
»  GIF (Graphics Interchange Format)
» JPEG (Joint Photographic Experts Group)
» TGA (Tagra)
» PNG (Portable Network Graphics)
Audio file formats:
» WAV (Waveform Audio File Format)
» MP3 (MPEG Layer-3 Format)
> OGG
C f_\,5 ) o
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»  AIFF (Audio Interchange File Format)
»  WMA (Windows Media Audio)
» RA (Real Audio Format)
Video file formats:
» AVI (Audio/Video Interleave)
» MPEG (Moving Picture Experts Group)
» WMV (Windows Media Video)
» FLV (Flash Video)
» MKV (Matroska Video)
Multimedia Production:
» Multimedia Production is an efficient planning which assures that the project will be proceed
smoothly and certainly ensures that the information reaches the target audience:
» The two basic types of animations are Path animation and Frame animation.
v Path animation involves moving an object on a screen that has a constant background.
v/ In frame animations, multiple objects are allowed to travel Simultaneously
Web Master:
» The responsibility of the web master is to create and maintain an Internet web page.
» They convert a multimedia presentation into a web page.
The various file formats in multimedia are
1) Text Formats 2) Image Formats  3) Audio File Formats 4) Video File Formats
1) Text Formats:
RTF:
Rich Text Format is the primary file format introduced in 1987 by Microsoft with the
specification of their published products and for cross-platform documents interchange.
Plain text:
» Plain text files can be opened, read, and edited with most text editors.
» Commonly used are Notepad (Windows), Gedit or nano (Unix, Linux), TextEdit (Mac OSX)
and so on.
Image Formats:
TIFF (Tagged Image File Format):
»  TIFF format is common in desktop publishing world (high quality output), and is supported
by almost all software packages.
» Recent versions of TIFF allow image compression, and the format is comfortable for moving
large files between computers.
BMP (Bitmap):
» Initially BMP format is in use with Windows 3.1.
» BMP is quite large and uncompressed.
» BMP is used for the high-resolution or large images.
DIB (Device Independent Bitmap):
This format which is similar to BMP, allows the files to be displayed on a variety of devices.
GIF (Graphics Interchange Format):
» GIF is a compressed image format.
» Most of the computer color images and backgrounds are GIF files.
- 6 ) -
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JPEG (Joint Photographic Experts Group):

JPEG was designed to attain maximum image compression. It uses lossy compression
technique, where a compression method is referred that loses some of the data required for
the image reconstruction.

JPEG works good with photographs, naturalistic artwork, and similar material but functions
less on lettering, live drawings or simple cartoons.

TGA (Tagra):

TGA is the first popular format for high resolution images.

TGA is supported by Most of the video-capture boards.

PNG (Portable Network Graphics):

An extensible file format for the less loss,portable and well compressed storage of raster
images.

PNG acts as replacement for GIF and also replaces multiple common uses of TIFF.

Digital Audio File Formats:

WAYV (Waveform Audio File Format):

WAV is the most popular audio file format in windows for storing uncompressed sound
files.

In order to attain the reduced file size it can also be converted-to other file formats like MP3.

MP3 (MPEG Layer-3 Format):

MPEG Layer-3 format is the most popular formatfor storing and downloading music.

The MP3 files are roughly compressed to one-tenth the size of an equivalent WAV file.
OGG:

A free, open source container format that is designed for obtaining better streaming and
evolving at high end quality digital multimedia.

OGG can be compared to MP3files in terms of quality.

AIFF (Audio Interchange File Format):

A standard audio file format used by Apple which is like a WAYV file for the Mac.

WMA (Windows Media Audio):

WMA is a popular windows media audio format owned by Microsoft and designed with
Digital Right Management (DRM) abilities for copyright protection.

RA (Real Audio Format):

Real Audio format is designed for streaming audio over the Internet.

The digital audio resources are usually stored as a computer file in computer’s hard drive or
CD/DVD.

Digital Video File Formats:

AVI (Audio/Video Interleave):

AVl is the video file format for Windows.

In AVI sound and picture elements are stored in alternate interleaved chunks in the file.
MPEG (Moving Picture Experts Group):

MPEG is a standard for generating digital video and audio compression under the
International Standards Organization (ISO) by the group of people.

7 ) "
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m Choose the correct answer 7. RTF (Rich Text Format) file format was
1. What is multimedia? introduced by -
(a) a type of computer hardware () TCS (b) Microsoft
(b) a type of computer software (c) Apple Inc. (d)IBM )
(c) a type of computer network Ans: (b) Microsoft
(d) the use of multiple forms of mediato | 8- The expansion of JPEG is
communicate information (a) Joint Photographic Experts Group
Ans: (d) theuse of multiple forms of media (b) Joint Photo Experts Group
to communicate information (c) Join Photon Experts Group
2. has five major components (d)joint p %mtographic press.group
like text, images, sound, video and Ans: (a) Joint Photographic Experts Group
animation. 9. AIFF file format was-developed by __
(a) Multimedia (b) Master Page (a) TCS (b) Microsoft
(c) Master item (d) Multi-word (c) Apple Inc. (d)IBM
Ans: (a) Multimedia Ans: (c) Apple Inc.
3. What is a raster image? 10. Which of the following is an audio file
(a) a type of image made up of pixels format?
(b) a type of image made up of geometric (a)MP3 (b) AVI
shapes (c) MPEG (d) PNG Ans: (a) MP3
(c) a type of image made up of text m Short Answers
(d) atype ofimage made up of sound waves Define Multimedia. Mar 2023
Ans: (a) a type of image made up of pixels Multimedia:
4. What is a vector image? Multimedia is an integration of many types
(a) a type of image made up of pixels of media like text, graphics, images, audio,
(b) a type of image made up of geometric animation, Video on a single medium in
shapes the same information unit.
(c) a type of image made up of text 2. List out Multimedia Components.
(d) atype ofimage made up of sound waves Multimedia has five major components
Ans: (b) a type of image made up of namely text, images, sound, video and
geometric shapes animation.
5. Which of the following is a raster image | 3. Classify the TEXT components in
file format? multimedia.
(a) JPEG (b) EPS Text:
(c) CDR (d)SVG Text is the basic components of multimedia
Ans: (a) JPEG and most common ways of communicating
6. Which of the following is a vector image information to other person.
file format? Text is of two types namely
(a) PSD (b) JPEG v Static Text
(c) EPS (d) BMP Ans: (c) EPS v Hypertext
C hS ) o
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Static Text:

v/ Static text, the text or the words will
remain static as a heading or in a line,
or in a paragraph.

v The words are given along with the
images to explain about the images.

v In static text the words will either give
information or support an image or a
video.

Hypertext:

v/ A hypertext is a system which consists
of nodes, the text and the links between
the nodes, which defines the paths the
user needs to follow for the text access
in non-sequential ways.

4. Classify the IMAGE components in
multimedia.
Image :

» Images acts as a vital components in
multimedia.

» These images are generated by the
computer in two ways namely
1. Bitmap or raster images
2. Vector images.

5. Define Animation.

Animation:

Animation is the process displaying still
images so quickly so that they give the
impression of continuous movement.

m Explain in Brief Answer

List out image file formats.

TIFF (Taqqed Image File Format)

BMP (Bitmap)

DIB (Device Independent Bitmap)

GIF (Graphics Interchange Format)

JPEG (Joint Photographic Experts Group)
TGA (Tagra)

PNG (Portable Network Graphics)

V V N|V V V V VYV YV H

List out audio file formats
WAV (Waveform Audio File Format)
MP3 (MPEG Layer-3 Format)

— J

OGG

AIFF (Audio Interchange File Format)
WMA (Windows Media Audio)

RA (Real Audio Format)

V VYV VYV W|V V VYV

List out video file formats

AVI (Audio/Video Interleave)

MPEG (Moving Picture Experts Group)
WMV (Windows Media Video)

FLV (Flash Video)

MKV (Matroska Video)

m Explain in detail

Explain in detail about production team
roles and responsibilities.

The fine quality: high-end multimedia
production « application requires a
specialized™ team comprising of the
members namely:

Production Manager

Content Specialist

Script Writer

Text Editor

Multimedia Architect

Computer Graphic Artist

Audio and Video Specialist

Computer Programmer

Web Master

Production Manager:

In a multimedia production, the role
of production manager is to define
and coordinate the production of the
multimedia project in time and with full
quality.

The production manager should be an
expertise in the technology expert, good
at proposal writing, good communication
skills and budget management skills.

The production manager must have
experienceinhumanresource management
and act as an efficient team leader.

AR IR T VAR NN

Content Specialist:
Content specialist is responsible for
performing  all  research  activities
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concerned with the proposed application’s
content.

Program content refers
information, graphics,
presented  through
production.

to projects
data or facts
the multimedia

Script Writer:

Video and film scripts represent a linear
sequence of events.

The script writer visualizes the concepts
in three dimensional environments and if
needed uses the virtual reality integration
into the program.

Text Editor:

The content of a multimedia production
always must flow logically and the text
should always be structured and correct
grammatically.

Text and narration is an integrated part of
the application.

Multimedia Architect:

The multimedia architect integrates all the
multimedia building blocks like graphics,
text, audio, music, video, photos and
animation by using authoring software.

Computer Graphic Artist:

The role of Computer Graphic Artist
is to deal with the graphic elements of
the programs like backgrounds, bullets,
buttons, pictures " editing,3-D  objects,
animation, and logos etc.

Audio and Video Specialist:
The roles of these specialists are needed for
dealing with narration and digitized videos
to be added in a multimedia presentation.
They are responsible for recording, editing
sound effects and digitizing.

Computer Programmer:

The computer programmer writes the
lines of code or scripts in the appropriate
language.

These scripts usually develop special
functions like developing the software to
give the size and shape of video windows,
controlling peripherals and so on.

Web Master:

The responsibility of the web master is to
create and maintain an Internet web page.
They convert a multimedia presentation
into a web page.

Final multimedia product is ready for
consultation is a joint effort of the entire
team.

Initially, the production manager identifies
the project content, while the web master
provides access to. a wide range of
community. through web-services.

{10 )

Explain in detail about different file
formats in multimedia files.

The various file formats in multimedia are
a) -Text Formats

b).Image Formats

¢) Audio File Formats

d) Video File Formats

a) Text Formats:

RTF:

Rich Text Format is the primary file format
introduced in 1987 by Microsoft with the
specification of their published products
and for cross-platform  documents
interchange.

Plain text:

Plain text files can be opened, read, and
edited with most text editors.

Commonly used are Notepad (Windows),
Gedit or nano (Unix, Linux), TextEdit (Mac
OSX) and so on.

Other computer programs are also capable
of reading and importing plain text.

Plain text is the original and popular way
of conveying an e-mail.
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v

v

b) Image Formats:

TIFF (Tagged Image File Format):

TIFF format is common in desktop
publishing world (high quality output),
and is supported by almost all software
packages.

Recent versions of TIFF allow image
compression, and the format is comfortable
for moving large files between computers.
BMP (Bitmap):

Initially BMP format is in use with
Windows 3.1.

BMP is quite large and uncompressed.
BMP is used for the high-resolution or
large images.

DIB (Device Independent Bitmap):

This format which is similar to BMP,
allows the files to be displayed on a variety
of devices.

GIF (Graphics Interchange Format):

GIF is a compressed image format.

Most of the computer color images and
backgrounds are GIF files.

GIF file format is best suitable for graphics
that uses only limited colors, and it is the
most popular format used for online color
photos.

13-bit Color look up table is used by the
GIF format to identify its color values.

GIF format is supported widely:.

JPEG (Joint Photographic Experts Group):
JPEG was designed to attain maximum
image compression. It uses lossy
compression . technique, = where a
compression method is referred that loses
some of the data required for the image
reconstruction.

JPEG works good with photographs,
naturalistic artwork, and similar material
but functions less on lettering, live
drawings or simple cartoons.

TGA (Tagra):

TGA is the first popular format for high
resolution images.

{11 )

TGA is supported by Most of the video-
capture boards.

PNG (Portable Network Graphics):

An extensible file format for the less loss,
portable and well compressed storage of
raster images.

PNG acts as replacement for GIF and also
replaces multiple common uses of TIFF.
PNG works good with online viewing
applications like worldwide web.

So it is fully streamable with a best display
option.

c) Digital Audio File Formats:

WAV (Waveform Audio File Format):
WAV is the most popular audio file format
in windows. for storing uncompressed
sound files:

In order to attain the reduced file size it
can'also be converted to other file formats

like MP3.

MP3 (MPEG Layer-3 Format):

MPEG Layer-3 format is the most popular
format for storing and downloading music.
The MP3 files are roughly compressed to
one-tenth the size of an equivalent WAV
file.

OGG:

A free, open source container format that
is designed for obtaining better streaming
and evolving at high end quality digital
multimedia.

OGG can be compared to MP3 files in
terms of quality.

AIFF (Audio Interchange File Format):

A standard audio file format used by Apple
which is like a WAV file for the Mac.

d) WMA (Windows Media Audio):
WMA is a popular windows media audio
format owned by Microsoft and designed
with Digital Right Management (DRM)
abilities for copyright protection.
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RA (Real Audio Format): MPEG (Moving Picture Experts Group):

» Real Audio format is designed for |» MPEG is a standard for generating digital
streaming audio over the Internet. video and audio compression under the

» The digital audio resources are usuallly International ~ Standards ~ Organization
T 5 computr e n COmPUEES | 150y thegroup ofpeole

» Besides the variety of audio file formats | » The group has developed MPEG-1, the
available, the most common formats are standard on which Video CD and MP3 are
wave files (WAV) and MPEGLayer-3 files based, MPEG-2, the standard that supports
(.MP3), WMA and RA. products as Digital Television set top
Digital Video File Formats: boxes and DVD, MPEG-4, the standard
AVI (Audio/Video Interleave): for multimedia and mobile web.MPEG-7,

»  AVlis the video file format for Windows. the standard for search.of audio and visual

» In AVI sound and picture elements are

stored in alternate interleaved chunks in
the file.

content.

PART Il - ADDITIONAL QUESTIONS

[ZITHI Choose the correct answer

1.

refers to any type of application
that involves more than one type of media
such as text, graphics video animation
and sound
(a) an executable file
(b) desktop publishing
(c) multimedia

(d) hypertext Ans: (c) multimedia

One of the disadvantages of the
multimedia is its
(a) cost

(c) usability

(b) adaptability
(d)relativity
Ans: (a) cost

You need hardware, software and
to make multimedia
(a) network
(b) compact disk drive
(c) good idea
(d) programming knowledge
Ans: (d) programming knowledge

Match the following by choosing the
right one

i) Text-TGA

ii) Image - MIDI

iii) Sound'- MPEG
iv) Video - RTF
(a) i 11, iii, iv

(€) iV i, iii

(b) ii, iii, iv, i
(d)iii, iv, i, ii
Ans: (b) ii, iii, iv, i

Find the odd one on the following which
is not an image format
(a) TIFF (b) BMP
(c) RTF (d)JPEG
Ans: (c) RTF

is the process displaying still
images they give continuous movement
(a) Text formats (b) Sound
(c) MP3 (d) Animation
Ans: (d) Animation

The live telecasting of real time program
through Internet is known as

(a) web casting

(b) web hosting

(c) data manipulation

(d) none of the above Ans: (a) web casting

(12 )

GIF use color look up table
(a) 8 bit (b) 8 KB
(c) 8 MB (d) 13bit

Ans: (d) 13bit
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9. is the process of conducting
conference between more than two
participants at different sites by using
computer networks
(a) Video conferencing (b) Web casting
(c) Web hosting (d) Alloftheabove

Ans: (a) Video conferencing

10. is a free-standing furnished
equipped multimedia computer that
allow users to retrieve information via a
touch screen.

(a) Kiosk (b) Maya
(c) PHP (d) Python
Ans: (a) Kiosk

11. Rich Text Format is the primary file

format introduced in

(a) 1989 (b) 1999
(€)1997 (d) 1987 Ans: (d) 1987
12. image format is used for the
high-resolution or large images
(a) TIFF (b) GIF
(c) BMP (d)JPEG
Ans: (c) BMP
13. Copyright issues are considered in
phase.
(a) Conceptual Analysis and Planning
(b) Project design
(c) Pre-production
(d) Budgeting
Ans: (a) Conceptual Analysis and Planning
14. phase includes the activities
like background music selection, sound
recording
(a) Testing
(b) Production

(c) Delivering the Multimedia Product
(d) Documentation  Ans: (b) Production

15. The visualizes the concepts in
three dimensional environments and if
needed use the virtual reality integration
into the pro ram.

- {13 )

(a) Script writer

(b) Production manager

(c) Editor

(d) Contentspecialist Ans: (a) Script writer

16.

The integrates all the
multimedia building blocks
(a) Script writer
(b) Multimedia Architect
(c) Editor
(d) Web Master
Ans: (b) Multimedia Architect

17.

Expansion of TIFF is :
(a) Tagged Image File Format
(b) Tag ImgFrm
(c) Tegged Image File Format
(d) Tripple Image File Format
Ans: (a) Tagged Image File Format

18. is the basic components of
multimedia
(a) Text (b) Animation
(c).Audio (d) VideoAns:(a) Text
19. Classifications of text are and
(a) Static and Hypertext
(b) Static and Text
(c) Hyper and Text
(d) All of the above

Ans: (a) Static and Hypertext

20.

The powerful way to convey information
in multimedia applications are
(a) Compression of video

(b) Embedding of video
(c) Displaying video
(d) None of these
Ans: (b) Embedding of video
21. The responsibility of the is to

create and maintain an Internet web page
(a) Script write

(b) Multimedia Architect

(c) Editor

(d) Web Master Ans: (d) Web Master
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22. Expansion of RTF is » Commonly used are Notepad (Windows),

a) Rich Textual Format
b) Rich Text Format
c) Riche Text Format >
d) Rich Text Formate

Ans: b) Rich Text Format

Gedit or nano (Unix, Linux), TextEdit (Mac
OSX) and so on.

Other computer programs are also capable
of reading and importing plain text.

Plain text is the original and popular way
of conveying an e-mail.

>
23. Expansion of WAV
a) Wide Audio Video 5.
b) Width Audio Video
c) Waveform Audio File Format >
d) None of these >

Ans: ¢) Waveform Audio File Format

24. The live telecasting of real time program | ;.
throughinternetis knownas

Write short notes on GIF

GIF (Graphics Interchange Format):

GIF is a compressed image format.

Most of the computer color images and
backgrounds are GIF files:

GIF file format is best suitable for graphics
that uses only limited. colors, and it is the
most popular format used for online color
photos.

13-bit Color look up table is used by the
GIF format toidentify its color values.

GIFE format is supported widely.

a) web hosting b) data manipulation
c) web casting d) none of the above
Ans: ¢) web casting |
m Short Answers
Write short notes on RTF. >
RTF: 6.

Rich Text Format is the primary file format
introduced in 1987 by Microsoft with the | »
specification of their published products
and for cross-platform  documents | »

Write short notes on BMP .

BMP (Bitmap):

Initially BMP format is in wuse with
Windows 3.1.

BMP is quite large and uncompressed.

BMP is used for the high-resolution or
large images.

interchange. >
2.  Write short notes on TIFF.
TIFF (Tagged Image File Format): 7.

» TIFF format is common in desktop
publishing world (high®quality output), | »
and is supported by.almost all software
packages.

» Recent versions “of TIFF allow image
compression, and the format is comfortable
for movinglarge files between computers.

3. Write short notes on DIB. >
DIB (Device Independent Bitmap):
This format which is similar to BMP,

Write short notes on JPEG.

JPEG (Joint Photographic Experts Group):
JPEG was designed to attain maximum
image compression. It uses lossy
compression  technique,  where a
compression method is referred that loses
some of the data required for the image
reconstruction.

JPEG works good with photographs,
naturalistic artwork, and similar material
but functions less on lettering, live
drawings or simple cartoons.

allows the files to be displayed on a variety
of devices. 8.

4. Write short notes on Plain text.
Plain text: >

» Plain text files can be opened, read, and
edited with most text editors.

Write short notes on PNG.

PNG (Portable Network Graphics):

An extensible file format for the less loss,
portable and well compressed storage of
raster images.

- {14 )
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>

PNG acts as replacement for GIF and also
replaces multiple common uses of TIFF.

PNG works well with online viewing
applications like worldwide web. so it is
fully streamable with a best display option.

Write short notes on Digital Video File
Formats:

Digital Video File Formats:

AVI (Audio/Video Interleave):

AVl is the video file format for Windows.

In AVI sound and picture elements are
stored in alternate interleaved chunks in
the file.

MPEG (Moving Picture Experts Group):
MPEG is a standard for generating digital
video and audio compression under the
International Standards Organization(ISO)
by the group of people.

The group has developed MPEG-1, the
standard on which Video CD and MP3 are
based, MPEG-2, the standard that supports
products as Digital Television set top
boxes and DVD, MPEG-4, the standard
for multimedia and mobile web.MPEG-7,
the standard for search of audio and visual
content.

10.

Write short notes on Digital Audio File
Formats.

Digital Audio File Formats:

WAV (Waveform Audio File Format):
WAV is the most popular audio file format
in windows for storing uncompressed
sound files.

In order to attain the reduced file size it
can also be converted to other file formats
like MP3.

MP3 (MPEG Layer-3 Format):

MPEG Layer-3 format is the most popular
format for storing and downloading music.

The MP3 files are roughly compressed to
one-tenth the size of an equivalent WAV
tile.

11.

Write short notes on OGG, AIFF.

OGG:

A free, open source container format that
is designed for obtaining better streaming
and evolving at high end quality digital
multimedia.

OGG can be compared to MP3files in terms
of quality.

AIFF (Audio Interchange File Format):

A standard audio file format used by Apple
which is like a WAV file for the Mac.

12.

Write short notes on WMA, RA.
WMA (Windows Media Audio):
WMA is a popular windows media audio
format owned by Microsoft and designed
with Digital Right Management (DRM)
abilities for copyright protection.

RA(Real Audio Format):
Real “Audio format is designed for
streaming audio over the Internet.

The digital audio resources are usually
stored as a computer file in computer’s
hard drive or CD/DVD.

Besides the variety of audio file formats
available, the most common formats are
wave files (WAV) and MPEGLayer-3 files
(.MP3), WMA and RA.

13.

Define: Hypertext.

A hypertext is a system which consists of
nodes, the text and the links between the
nodes, which defines the paths the user;
need to follow for the text access in non-
sequential ways.

14.

{15 )

Define: Analog Video.

In Analog video, the video data’s are
stored in any non-computer media like
video tape, laserdisc, film etc.

It is divided further in two types as

Composite and Component Analogue
Video.
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» Composite analog Video has all the video | 18. Write a role of Multimedia in Education.
components like brightness, color, and |  Multimedia plays a vital role in offering an
synchronization combined into one signal. excellent alternative method to traditional

» Due to the combining of the video teaching by allowing the students to
components, the quality of the composite explore and learn various concepts through
video resulted in color blending, low animation.
clarity and high generational loss. » Students, teachers and the parents enjoy

» This recording format was used for this multimedia mode of learning and
customer analog video recording tape multimedia learning materials.
formats such as Betamax and VHS. » Many educators accept multimedia

15. Write short notes on TGA. introduces new ways of thinking in the
TGA (Tagra): classroom.

» TGA is the first popular format for high | 19, Write a role of EDUSAT in India.
resolution images. » In India, multimedia is used in different

» TGA is supported by Most of the video- ways for .teaching and learning like
capture boards. e-learning, © distance learning, virtual

16. Define: Digital Audio. learning and so on.

Digital Audio » EDUSAT (Education Satellite) is launched
Sampled sound is a Digitized sound. inIndia for serving the educational sector
A sample of sound is taken and stored of-“the country for emulating virtual
every nth fraction of a second as digital classroom in an effective manner.
information in bits and bytes. 20. Write a role of Multimedia in

» The quality of this recording depends on Entertainment.
the sampling rate. » The remarkable advancement in the

» Sampling rate is defined as how often the enter.tainn}ent industry iS_ due to the
samples are taken and how many numbers Multimedia Technology mainly.
are used to represent the“value of each | » Multimedia technology is needed in all
sample (bit depth, resolution and sample mode of entertainment like radio, TV,
size). online gaming, video on demand etc.

» The finer the quality of the captured | > Videoon demand or movies on demand is
sound and the resolution is achieved while a service that provides movies to television
played back, when more often the sample sets on an individual basis at homes.
is taken and the more data is stored about | » Movies are stored in a central server and
that sample. transmitted through a communication

17. Define: Musical Instrument Digital network.
Identifier (MIDI). 21. Write a role of Multimedia in Medical
Musical Instrument Digital Identifier Services.
(MIDI) is a standard communication tO(_)l » Medical services are grown drastically
.developed for computers and electronic with the development of multimedia.
Instruments.

o { 16 ) ]
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>

Medical Students practices surgery
methods via simulation prior to actual
surgery.

Tiny digital cameras are inserted in human

body and it displays the inner scene of the
body

In this way the medical practitioners were
able to see the inner part without dissecting
it.

22,

Write a role of Multimedia in
Multimedia Conferencing,.

Multimedia conferencing or video
conferencing is a system that performs face-
to-face interactions among participating
users, located far from each other, as if
they were sitting and discussing in a single
room.

23.

Define Multimedia Production
Multimedia Production is an efficient
planning which assures that the project
will be proceed smoothly and certainly
ensures that the information reaches the
target audience.

N
=

vV V.V V V V V V V

List out Multimedia Production team
members

Production Manager
Content Specialist

Script Writer

Text Editor

Multimedia Architect
Computer Graphic Artist
Audio and Video Specialist
Computer Programmer
Web Master

N
g1

. Define webcasting.

Mar 2023

The live telecast of real time programs
through internet is known as webcasting.

IR Explain in detail

1.
»>

Explain the applications of Multimedia.

Multimedia is the most fast growing area
in the field of information technology.

{17 )

A Multimedia is an application which is a
collection of multiple media sources like
text, images, sound/audio, animation and
video on a single platform. Predominantly,
Entertainment and Education are the fields
where multimedia is used in majority.

1. Education:

Multimedia plays a vital role in offering an
excellent alternative method to traditional
teaching by allowing the students to
explore and learn various concepts through
animation.

Students, teachers.and. the parents enjoy
this multimedia mode of learning and
multimedia learning materials.

Multimedia based teaching and learning
system 'named as MODULO at GMU
in Germany developed is a webbased
environment that aims to provide students
with flexible and decentralized learning
environment based on their educational
background.

In India, multimedia is used in different
ways for teaching and learning like
e-learning, distance learning, virtual
learning and so on.

EDUSAT (Education Satellite) is launched
in India for serving the educational sector
of the country for emulating virtual
classroom in an effective manner.

2. Entertainment:

The remarkable advancement in the
entertainment industry is due to the
Multimedia Technology mainly.

This technology is needed in all mode
of entertainment like radio, TV, online
gaming, video on demand etc. Video on
demand or movies on demand is a service
that provides movies to television sets on
an individual basis at homes.

Kindly send me your study materials to padasalai.net@gmail.com


https://www.padasalai.net/
https://www.padasalai.net/

www.Padasalai.Net www.CBSEtips.in

OfO#Old EC 12® 0 Computer Application

»  Movies are stored in a central server and pictures, graphics, diagrams, maps, audio
transmitted through a communication and text. Banks uses kiosks in the form of
network. ATM machines.

» A set-top box connected to the 6. Multimedia Conferencing:
communication network converts the Multimedia conferencing or
inputs it to the television set. performs face-to-face interactions among
3. Business Systems: participating users, located far from each

» Business applications for multimedia other, as if they were sitting and discussing
include presentations, training, internet in a single room.
protocols and so on. 2. Explain in detail Process.of Multimedia.

» The marketing and advertising agencies Steps in Multimedia Production
are using animation techniques for sales Adequate time and efficient planning is
promotion. required for multimedia production, which

» High resolution projectors are common for assures that the project will be proceed
multimedia presentations on the road. smoothly and certainly ensures that the

» Cell phones and personal digital information reaches the target audience.
a§51stants Wlth_ Bluetooth ~and ~ Wi- Phases for development of complex
Fi communication technology make multimedia projects are:
multimedia communication for business C tual Analvsi 4Pl .

fficient] ¢ Conceptual Analysis and Planning:
more etictently: /. Project design
4. Medical Services: v/ Pre-production

» Medical services are grown drastically / Budgeting
with the development of multimedia. v/ Multimedia Production Team

» Medical Students practices surgery v Hardware/Software Selection
methods via simulation prior to actual v/ Defining the Content
SUrgery. v/ Preparing the structure

» Tiny digital cameras ‘are  inserted in v/ Production
human body and it displays the inner site v/ Testing
of the body through. which the medical v/ Documentation
practitioners can see the internal parts v/ Delivering the Multimedia Product
without actually dissecting it. ) i

. 1. Conceptual Analysis and Planning:

5. Public Places: . . s
) R ) ) . | » Conceptual analysis identifies an

» Multimedia is available in many public .

_ . _ _ appropriate theme, budget and content
places like trade shows, libraries, railway vailabilitv on that selected theme
stations, museums, malls, airports, banks, ' y. . ' '
hotels and exhibitions in the form of kiosks. | > ~ Copyright issues also are considered in

» It helps the customers by providing this phase.
information to them. 2. Project design:

» The information presented in kiosk are Goa'lls, Ob].ectlves are contribute to the
enriched with animation, video, still Project design phase.

= { 18 ) m
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3. Pre-production: 3. Explain in detail Techniques of Animation.

Based on the planning and design, it is Animation is the process displaying still

necessary to develop the project. images so quickly so that they give the

4. Budgeting: impression of continuous movement.

Budgeting for each phases like COI’lSLl.ltaI.’ltS, Features:

hardware,' so‘ftwa%‘e, tra\.7e1, communication | . 1 animation the screen object is a vector

and publishing is estimated for all the : : P

. : i image in animation.
multimedia projects. Usi ool transt ; th
. . . > sing numerical transformations the

5. Multimedia Production Team: 5 . . .

. . . . movement of that image along its paths is
Script writer, Production manager, Editor, leulated for their defin 4
Graphics Architect, Multimedia Architect calculated for their detiming coordinates.
and Web Master are there in Multimedia | » Theleastframe rate of atleast16 frames per
Production Team second gives the impression of smoothness
Hardware includes the selection of fastest least 25 frames per second.

CPU, RAM and huge monitors, sufficient Techniques:
disc for storing the records. » Animations'may be in two dimensional or
7. Defining the Content: three dimensional.
Cont.en.t is the “stuf Ij proylded b.y content |, Thd two dimensional animation, bring an
specialist to the multimedia architect imagealive, that occur on the flat X and Y
8. Preparing the structure: axis of the screen.
This structure defines the activities, . . o .
. . > _In three dimensional animations it occurs
responsible person for each activity and : the th X Y and 7
the start/end time for each activity. along the three axes A, 1 and £.
9. Production: » Animation tools are very powerful and
In the multimedia application, after the effective.
pre-production activities, the production [ » The two basic types of animations are Path
phase starts. This phase’ includes the animation and Frame animation.
activities like background music selection, v Path animation involves moving an
sound recording and so on. object on a screen that has a constant
10. Testing: background.
The Complete testing of the pﬂOt pI'OdLICt v/ In frame animations, multiple objects
is done before the mass production to are allowed to travel simultaneously.
ensure.tlr.lat every’fhmg is in place,. There 4. Briefly explain about Multimedia
by avoiding the failure after launch.
) Components.

11. Documentat19n. Multimedia has five major components
The docgmentatlor} has all the valuable namely text, images, sound, video and
mfor.matlon's. starting from the sygtem animation.
requirement till the completion of testing. Text:
12. D.elive.ring th.e Multimedia P“’CF““: Text is the basic components of multimedia
Multimedia appl.lcatlons are best delivered and most common ways of communicating
on CD/DVD or in the website information to other person.

o { 19 ) ]
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Text is of two types namely
Static Text
Hypertext

Static Text:

Static text, the text or the words will
remain static as a heading or in a line, or in
a paragraph.

The words are given along with the images
to explain about the images.

In static text the words will either give
information or support an image or a
video.

Hypertext:

A hypertext is a system which consists
of nodes, the text and the links between
the nodes, which defines the paths the
user needs to follow for the text access in
non-sequential ways.

~000=

Image:
Images acts as a vital component in
multimedia.

Images are generated by the computer in
two ways, as bitmap or raster images and
as vector images.

3) Sound:

Sound is a meaningful speech in any
language and is the most serious element
in multimedia, providing the pleasure of
music, special effects and.so on.

4) Video:

Video is defined as.the display of recorded
event, scene .

5) Animation:

Animation is the process displaying still
images so quickly so that they give the
impression of continuous movement.
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An Introduction to Adobe PageMaker

An Introduction to Adobe PageMaker-An Overview

Desktop publishing;:
Desktop publishing (abbreviated DTP) is the creation of page layouts for documents using
DTP software.

Pasteboard in PageMaker:
When we create a document a document page is displayed within a dark border.
The area outside of the dark border is referred to as the pasteboard.

Menu bar of PageMaker:

Menu bar of PageMaker contains File, Edit, Layout, Type, Element, Utilities, View, Window,
Help menus.

When we click on a menu item, a pull down menu appears.

There may be sub-menus under certain options in the pull-down menus.

Menu bar

File Edit Layout Type Element Utilities View ~Window Help

Text editing:

Entering a new text or modifying the existing text in @ document is called as text editing.
Text block:

A text block contains text you type, paste, or import.

We cannot see the borders of a text block until we select it with the pointer tool.

Threading text blocks:

A Text block can be connected to other text block so that the text in one text block can flow
into another

text block.

Text blocks that are connected in this way are threaded.

Threading text:

The process of connecting text among Text blocks is called threading text.

Components of Menu bar:

Toolbar »  Scroll bars
Ruler »  Text area.
Menu options available in Menu bar:

File »  Utilities
Edit > View
Layout >  Window
Type » Help.
Element

Story.

Text that flows through one or more threaded blocks is called a story.

Master Pages:
Master Pages commonly contain repeating logos, page numbers, headers, and footers.
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